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About this document
This document is a global document. Please contact your system supplier or 
your Nortel Networks representative to verify that the hardware and software 
described are supported in your area.

How to use this guide
Complete the installation tasks in sequence. Start at the first page and proceed 
through the procedures until the end of this guide is reached.

Target audience
The DECT Installation Guide provides information for installers, site 
maintenance personnel, and administrators.

Identifying Nortel Networks PBX systems
The following systems are referred to in this guide as large systems:

• Option 51

• Option 61

• Option 71

• Option 81

• Option 51C

• Option 61C

• Option 81C

The following systems are referred to as small systems:

• Option 11

• Option 11E
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• Option 11C

• Option 11C Mini

• Succession Communication Server for Enterprise 1000

CAUTION:  Data loss
This symbol alerts you to a procedure that can result in a loss of data.

CAUTION:  Electrostatic sensitive device
This symbol alerts you to a procedure that can result in equipment 
damage due to ElectroStatic Discharge (ESD).

DANGER:  Electric shock
This symbol alerts you to the risk of serious injury, or death, caused by an 
electric shock.

DANGER:  Serious injury
This symbol alerts you to the risk of serious injury, or death, caused by an 
immediate hazard.
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Hardware installation introduction
Introduction

This chapter contains information on the following topics:

Before you begin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Unpack and examine the equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Reference list
The following are the references in this section:

• DECT Provisioning Records (553-3601-102)

Before you begin
Before the DECT system is installed, the following tasks must be completed:

• the site survey

• the deployment

• the installation of the house wiring for base stations

Before the DECT system is installed, the following information and materials 
are required:

• site work order

• list of equipment to be installed, showing quantities

•  DECT Provisioning Records (553-3601-102)

• a marked-up floor plan

• a volt/ohm meter
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• hand tools and hardware, such as

— screwdrivers and pliers

— spanners and socket wrenches

— drill and drill bits

— screws and screw anchors

— punch-down tools for MDF and RJ-45 surface mount jacks

— cable continuity checking equipment

Unpack and examine the equipment
Complete the following steps:

Note: Store the equipment containers away from the installation area. 
Use the containers to return damaged equipment.

Table 1
Unpack and examine the equipment

Step Act ion

1 Check the items shipped for discrepancies against the list of equipment required for the 
installation.

If any items are missing, take the action that is appropriate for 
this situation.

2 Carefully unpack and examine the equipment for damage.

If any items are missing, take the action that is appropriate for 
this situation. 

END
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Install base station
Contents

This chapter contains information on the following topics:

DECT base station rules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Compatibility. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Install C4600, C4610, and C4610E base stations. . . . . . . . . . . . . . . . . . 18
Install Base Station wiring to the MDF. . . . . . . . . . . . . . . . . . . . . . . 20

Install the base station external power supply. .  . . . . . . . . . . . . . . . . . . 24

Install base station in the external housing. . . . . . . . . . . . . . . . . . . . . . . 27

Attach the external housing to a wall. .  . . . . . . . . . . . . . . . . . . . . . . . . . 30

Connect the external housing wiring to the MDF. . . . . . . . . . . . . . . . . . 32

Reference list
The following are the references in this section:

• System Installation Procedures (553-3001-210)

DECT base station rules
Be aware of the following rules:

• DC powered Meridian systems input voltage of at least –48 volts is 
required for maximum base station line length.

• One hundred ohms is the maximum line length for a C4610 high traffic 
base station. If the line measurement approaches 100 ohms, use an 
external power supply.

• If the exact location is not accessible, mount the base station as close as 
possible to the location in the site survey.
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• Mount the base station in a vertical position, not horizontally, on a 
ceiling.

• Lead the base station cable directly away from the base station. Surplus 
cable can cause base station malfunctions.

• Place the base station where it is unlikely to be damaged. For example, a 
base station in a warehouse must be placed where it cannot be damaged 
by a forklift truck.

• Surrounding objects must not affect the base station. For example, a base 
station in a car park needs to be placed higher than any vehicle parked 
next to it.

• The minimum distance between two base stations must be greater than 
two meters.

• Do not mount base stations on large concrete or stone columns, air ducts 
or large metal objects.

• The external base station is powered from the line connection and does 
not require a mains connection.

• Use the external housing kit to mount any base station out-of-doors.

• Use the external housing kit for any base station subject to conductive 
pollution or dust that could become conductive due to condensation.

Compatibility
The C4600, C4610, and C4610E base stations are compatible with all DECT, 
Meridian 1, and Succession CSE 1000 software releases. The base stations 
are backward compatible.

C4610E base station
The C4610E 12-channel base station has an adaptor to support an external 
antenna. The external antenna increases the operating distance between the 
base station and the DECT handset. Nortel Networks recommends the use of 
a Huber & Suhner dual-planar directional antenna. Directional antennas are 
suitable for use in places such as large halls, outside parking lots, and between 
buildings. See Figure 1 on page 17.
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Note: The Huber & Suhner 8.0dBi and 10.5dBi antenna packages were 
tested with the C4610E base station. Other third-party directional 
antenna are available, but have not been tested with this base station.

Figure 1
A Huber & Suhner dual-planar directional antenna 
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Install C4600, C4610, and C4610E base stations
Consult the work order and marked-up floor plan to determine the position of 
the base station, then perform the steps in Table 2 on page 19:

Figure 2
Base station mounting details

a. screw mounting slot 

b. screw and cable tie retaining washer hole

c. cable tie grooves

553-8142
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Table 2
Install C4600, C4610, and C4610E base station

Step Act ion

1 Locate the base station mounting position.

2 Install the base station mounting screw.

If required, drill the holes for a screw anchor and install the anchor.

3 Fasten the base station on the wall or a building protrusion.

Hang the base station on the screw or use cable ties to mount the base station. Insert 
the cable ties in the vertical or horizontal grooves on the back of the base station. 
Secure the cable ties to the base station with the retaining washers and screws 
provided. Fasten the cable ties to the building protrusion.

4 If installing the C4610E base station, install the external antenna according to the 
manufacturer’s instructions.

 

END
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Install Base Station wiring to the MDF
Consult the work order and marked-up floor plan to determine the base 
station to MDF connections, then follow the steps in Table 3 on page 21.

Figure 3
Base station, MDF, and I/O panel details

a. RJ-45 single surface mount jack

b. MDF

c. recommended UTP Cat 5 cable

d. IPE shelf I/O connector panel

CAUTION:  Service interruption
For maximum line length before signal degradation occurs, use UTP Cat 5 
cabling between the base station and the shelf or cabinet. If the line length 
exceeds 100 ohms for the 4610 base station, an external power supply must 
be used.

The maximum distance when using external power with UTP Cat 5 cabling is 
approximately 1.7 km.
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Note: The BIX tip and ring connections shown in Table 4 on page 22 
correspond to standard BIX designation. The first pair are labeled T0 and 
R0. See System Installation Procedures (553-3001-210), section 
Planning and Designating the MDF.

Table 3
Install Base Station wiring to the MDF 

Step Act ion

1 Connect one end of the NTCW10 cable into the base station RJ-45 jack.

Use the supplied cable.

2 Install the RJ-45 single surface mount jack.

Use the NTCW10 cable length to measure the location of the RJ-45 surface mount 
jack.

3 Connect a UTP3/UTP5 cable from the MDF house side to the RJ-45 surface mount 
jack.

Table 4 on page 22 shows the RJ-45 plug/socket to MDF connections. For DMC8s 
type NTCW00AB and NTCW01AB connect from base station 1 to base station 8.

Note:  To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules 
requires 24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 
from 16 pair to 24 pair, see System Installation Procedures (553-3001-210), 
Appendix C.

4 Connect the free end of the NTCW10 cable into the RJ-45 surface mount jack.

END
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Figure 4
RJ-45 plug/socket connections to base station 1 MDF

Table 4
Base station RJ-45 to BIX MDF connections  (Part 1 of 2)

 Base station number
RJ-45 pin out of the plug 

and socket
MDF connection

Base station 1 4 T8 

Base station 1 5  R8

Base station 1 6  T9

Base station 1 3  R9

Base station 2 4  T10

Base station 2 5  R10

Base station 2 6  T11

Base station 2 3  R11

Base station 3 4  T12

Base station 3 5  R12

Base station 3 6  T13

553-8144
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Base station 3 3  R13

Base station 4 4  T14

Base station 4 5  R14

Base station 4 6  T15

Base station 4 3  R15

Base station 5 4 T16

Base station 5 5  R16

Base station 5 6  T17

Base station 5 3  R17

Base station 6 4  T18

Base station 6 5  R18

Base station 6 6  T19

Base station 6 3  R19

Base station 7 4  T20

Base station 7 5  R20

Base station 7 6  T21

Base station 7 3  R21

Base station 8 4  T22

Base station 8 5  R22

Base station 8 6  T23

Base station 8 3  R23

Table 4
Base station RJ-45 to BIX MDF connections  (Part 2 of 2)

 Base station number
RJ-45 pin out of the plug 

and socket
MDF connection
DECT Installation Guide



Page 24 of 222  Install base station
Install the base station external power supply

For the C4600, C4610, and C4610E base stations, an external power supply 
must be installed if the UTP Cat 5 line resistance exceeds 100 ohms.

Figure 5
C4610 base station external power
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Figure 6
C4610E external power and external antenna connectors 

External power connector

External antenna (SMA)
connectors
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Table 5
Install the C4610 base station external power supply 

Step Act ion

1 Remove the plastic stopper from the C4610 base station power socket.

The power socket is located next to the yellow LED.

2 Plug the external power supply jack into the C4610 base station 
power socket.

3 Connect the external power supply to the ac mains outlet.

END
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Install base station in the external housing
Consult the work order, then perform the steps in Table 7 on page 31:

Figure 7
External housing details

a. component mounting plate

b. power transformer (not used)

c. cable connecting box

d. base station

e. plate retaining nuts

f. cable outlet

g. external housing cabinet
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Figure 8
Base station mounting details 

CAUTION:  Equipment damage
The following procedure requires the removal of the base station cover. The 
circuit board is attached to the base station cover. Do not damage the circuit 
board or bend the two antennas on the bottom of the circuit board.
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Table 6
Install the base station in the external housing

Step Act ion

1 Open the external housing cover.

Insert the external housing key and turn clockwise.

2 Remove the base station mounting plate.

Unscrew the four nuts securing the plate and pull the plate from 
the cabinet.

3 Remove the base station cover. See the preceding caution note on page 28.

Carefully pry one corner of the cover from the base station, then the other corner. 

4 Remove the base station lower screw hole cover.

Push the screw hole cover out of the base station.

5 Mount the base station to the housing plate.

Affix with the screws as shown in Figure 8.

6 Replace the base station cover.

Snap the cover in place.

7 Connect the connecting box cable to the base station.

Snap the connecting box cable into the base station RJ-45 connector. Lead the cable 
away from the base station for optimal performance of the antennas.

8 Replace the base station mounting plate.

Secure the plate with the four nuts. 

END
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Attach the external housing to a wall
Consult the work order and marked-up floor plan to determine the position of 
the base station external housing, then perform the following steps:

Figure 9
External housing mounting lugs 

Figure 10
External housing wall mounting 
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DANGER:  Electric shock
Do not drill into electrical wires that are embedded in the wall.

Table 7
Attach the external housing to a wall

Step Act ion

1 Choose the vertical or horizontal mounting position.

See Figure 9 on page 30 for details. Reposition mounting lugs
 if necessary.

2 Drill mounting holes in the wall.

Use the drilling jig to align the holes.

3 Mount the external housing to the wall.

See Figure 10 on page 30 for details. Use the screws, and appropriate inserts, to 
fasten the housing to the wall.

END
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Connect the external housing wiring to the MDF
Consult the work order, then perform the steps in Table 8:

Figure 11
External housing MDF connection details  

Note:  The BIX tip and ring connections shown in Table 9 on page 33 
correspond to standard BIX designation. The first pair are labelled T0 
and R0. See System Installation Procedures (553-3001-210), section 
Planning and Designating the MDF.

Table 8
Connect the external housing wiring to the MDF  (Part 1 of 2)

Step Act ion

1 Lead the building cable into the external housing.

Route the cable through the cable outlet in the external housing.
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2 Secure the cable in the connecting box.

Use a cable tie-wrap.

3 Connect the external housing wiring from the connecting box to 
the MDF.

Note:  See Figure 11 on page 32 and Table 9 on page 33 for wiring connections.
 For DMC8 types NTCW00AB and NTCW01AB, connect from base station 1 to base 
station 8.

Note:  To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules 
requires 24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 
from 16 pair to 24 pair, see System Installation Procedures (553-3001-210), Appendix 
C.

Table 9
External housing base station to BIX MDF connections  (Part 1 of 2)

 External housing base station 
number

 External housing 
connector box pin 

number
MDF connection

Base station 1 3 T8 

Base station 1 4  R8

Base station 1 2  T9

Base station 1 5  R9

Base station 2 3  T10

Base station 2 4  R10

Base station 2 2  T11

Base station 2 5  R11

Base station 3 3  T12

Table 8
Connect the external housing wiring to the MDF  (Part 2 of 2)

Step Act ion

END
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Base station 3 4  R12

Base station 3 2  T13

Base station 3 5  R13

Base station 4 3  T14

Base station 4 4  R14

Base station 4 2  T15

Base station 5 4 T16

Base station 5 5  R16

Base station 5 6  T17

Base station 5 3  R17

Base station 6 4  T18

Base station 6 5  R18

Base station 6 6  T19

Base station 6 3  R19

Base station 7 4  T20

Base station 7 5  R20

Base station 7 6  T21

Base station 7 3  R21

Base station 8 4  T22

Base station 8 5  R22

Base station 8 6  T23

Base station 8 3  R23

Table 9
External housing base station to BIX MDF connections  (Part 2 of 2)

 External housing base station 
number

 External housing 
connector box pin 

number
MDF connection
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46
Install additional IPE shelves or
small system cabinets
Contents

This chapter contains information on the following topics:

Install additional IPE modules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Install additional small system cabinets. . . . . . . . . . . . . . . . . . . . . . . . . 38
Install IPE module wiring to the MDF. .  . . . . . . . . . . . . . . . . . . . . . 41
Install small system cabinet wiring to the MDF. . . . . . . . . . . . . . . . 45

Reference list
The following are the references in this section:

• Option 11C Planning and Installation (553-3021-210)

• System Installation Procedures (553-3001-210)

• Option 11C Mini Planning and Installation (553-3021-209)

• Succession CSE 1000 – Installation and Configuration Guide 
(553-3023-210)
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Install additional IPE modules
Consult the work order and marked-up floor plan to determine if additional 
IPE modules are required, then perform the steps in Table 10:

Note: If unfamiliar with this process, refer to System Installation 
Procedures (553-3001-210).

Table 10
Install additional IPE modules  (Part 1 of 2)

Step Act ion

1 Remove the IPE module front and rear covers.

Remove the covers from the module on which the DECT module will sit.

2 Remove the air grills.

Release the air grill tabs or Southco® fasteners and lift the air grill off.

3 Remove the top cap.

Loosen and remove the three front and rear top cap bolts. Lift off top cap.

4 Unfasten the column LED. 

Remove the LED bracket bolts.

5 Remove the I/O back panel cover.

Unlock the four Southco fasteners.

6 Disconnect the column LED.

Unlock LED wiring connector latches on the module backplane. Detach the LED wiring 
connector.

7 Disconnect the thermal sensor connector.

Unlock the sensor connector latches on the 36 pin orange/brown colored connector, 
located to the left of the LED connector. Unplug the sensor connector.

8 Remove the EMI perf panel.

Lift directly up.
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9 Place the new module on top of the column.

Keep hands and fingers out from under the module when placing the module on top of 
the equipment column.

10 Connect the new module wiring.

Install the sensor connector of the new module into the vertical connector housing of 
the module below.

11 Secure the new module.

Insert the five bolts and lock washers into the base of the new module. Tighten the 
bolts into the original module.

12 Attach the power cable.

Connect the ribbon cable of the new module to J2 of the module below.

13 Re-install the EMI perf panel and the LED.

Install the LED connector and the sensor connector on the 
new module.

14 Replace the air grills and covers.

Reverse the procedure for steps 1 to 4. 

Table 10
Install additional IPE modules  (Part 2 of 2)

Step Act ion

END
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Install additional small system cabinets
Consult the work order and marked-up floor plan to determine if additional 
small system cabinets are required, then perform the following steps:

Note: If not familiar with this process, refer to Option 11C Planning and 
Installation (553-3021-210).

CAUTION:  Electrostatic sensitive device
Wear a properly connected antistatic wrist strap to handle circuit cards. Only 
touch the edges. Do not touch the contacts or components. Set the cards on 
a protective antistatic bag. If an antistatic bag is not available, hand-hold the 
card, or set it in a card cage unseated from the connectors.

Table 11
Install additional small system cabinets  (Part 1 of 3)

Step Act ion

1 Mount the expansion cabinet.

For a wall mount, draw a level line, rest the bottom of mounting bracket on the line, 
screw the mounting bracket to the wall. Hang the cabinet on the mounting bracket. 
Fasten the bottom of the cabinet to the wall.
For a floor mount, install the cabinet on the pedestal. Position the cabinet according to 
the equipment layout plan.

2 Remove the drip tray.

Slide drip tray outward.

3 Install ground wire.

As a minimum, use #6AWG ground wire. Tag the main ground connection at the 
ground source to ensure it is not accidently discontinued. Test the ground.

4 Install the power supply.

Wear the anti-static wrist strap. Turn power supply circuit breaker to OFF. Check the 
option switches on the power supply.
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5 Install the fiber routing guide.

Mount the guide in the area below the circuit cards and secure with the existing 
screws.

6 Connect the fiber optic cable or copper cable as applicable. 

For the A0618443 cable, remove the two plugs on the Fiber Receiver card. Connect 
the cable to the card so the “V” shaped groove is facing inward. For the glass fiber 
optic cable, remove the plug on one connector on the card, and the cap on the cable. 
Insert the connector and secure with a half turn clockwise. Wind the excess cable on 
the storage device.

7 Insert the circuit cards in the expansion cabinet.

Refer to “Install DMC8-Es” Table 22 on page 58 and the work order for card 
placement.

8 Install or expand the MDF cross-connect terminal.

Consult the marked-up floor plan for the MDF addition location.

9 Install cables from the cabinet to the MDF cross-connect.

Consult the marked-up floor plan for the cable location.

10 Install PFTU and SDI cable if required.

Consult the marked-up floor plan for the cable location.

11 Replace the expansion cabinet drip tray.

Slide the drip tray inward.

12 Remove the main cabinet cover and drip tray.

Undo the catches on the main cabinet and slide the drip tray outward.

13 Install a Fiber Routing guide in the main cabinet, if required.

The Fiber Routing guide is secured to the under side of the bottom card rail and uses 
the screws to the left of the CPU card label and under the card 2 label.

14 Turn the power supply circuit breaker to OFF.

Table 11
Install additional small system cabinets  (Part 2 of 3)

Step Act ion
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15 Unseat the NTDK20 SSC card and install a Fiber Expansion daughterboard.

Connect the Fiber Expansion daughterboard to the connector “Fiber 1” if this is the first 
expansion cabinet, or to “Fiber 2” if this is the second expansion cabinet.

16 Connect the fiber optic cable to the Fiber Expansion daughterboard.

For the A0618443 cable, remove the two plugs on the Fiber Receiver card. Connect 
the cable to the card so the “V” shaped groove is facing inward. For the glass fiber 
optic cable, remove the plug on one connector on the card and the cap on the cable. 
Insert the connector and secure with a half turn clockwise. Wind the excess cable on 
the storage device.

17 Re-seat the NTDK20 SCC card.

18 Route the fiber optic cable through the Fiber Routing Guide.

19 Set the circuit breaker in the main cabinet to ON.

The system reloads. Check time and date using LD 2.

20 Re-install the drip tray in the main cabinet.

21 Re-install the main cabinet cover.

Table 11
Install additional small system cabinets  (Part 3 of 3)

Step Act ion

END
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Install IPE module wiring to the MDF
Consult the work order to determine the layout of the module I/O panel to 
MDF cabling route, then perform the steps in Table 12 on page 43.

Figure 12
IPE I/O cable to BIX MDF termination

CAUTION:  Service interruption
The existing MDF cabling can be used; however, UTP Cat 5 – NTCW15, 
NTCW16, or NTCW17 MDF to PBX cabling is recommended, as it provides a 
greater line length before signal degradation occurs.
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Note: In NT8D11AC or NT8D11DC CE/PE and NT8D37AC or 
NT8D37DC IPE modules, these BIX connectors are not used. However, 
they are used in the NT8D11BC or NT8D11EC CE/PE and NT8D37BA 
or NT8D37 EC IPE modules.

Figure 13
IPE I/O cable to Krone MDF termination 
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:

Table 12
Install IPE module wiring to the MDF

Step Act ion

1 Identify the UTP Cat 5 twenty-five pair MDF cable.

Label both ends of the cable with the IPE module number and the 
I/O panel letter designation.

2 Connect the IPE or cabinet end of the cable.

Insert the cable’s Amphenol® connector into the appropriate 
I/O panel connector. See Table 13 on page 43.

3 Run the cable to the MDF.

4 Terminate the cable on the MDF.

For BIX MDF, refer to Figure 12 on page 41 to locate the BIX connectors and Table 13 
on page 43 to locate the cable color code. For Krone MDF, refer to Figure 13 on page 
42 to locate the Krone connectors and Table 13 to locate the cable color code.

Table 13
Color code for 25 pair cable  (Part 1 of 2)

Amphenol pin number
Tip Ring

Body/Band Body/Band

26/1 White/Blue Blue/White

27/2 White/Orange Orange/White

28/3 White/Green Green/White

29/4 White/Brown Brown/White

30/5 White/Slate Slate/White

31/6 Red/Blue Blue/Red

END
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32/7 Red/Orange Orange/Red

33/8 Red/Green Green/Red

34/9 Red/Brown Brown/Red

35/10 Red/Slate Slate/Red

36/11 Black/Blue Blue/Black

37/12 Black/Orange Orange/Black

38/13 Black/Green Green/Black

39/14 Black/Brown Brown/Black

40/15 Black/Slate Slate/Black

41/16 Yellow/Blue Blue/Yellow

42/17 Yellow/Orange Orange/Yellow

43/18 Yellow/Green Green/Yellow

44/19 Yellow/Brown Brown/Yellow

45/20 Yellow/Slate Slate/Yellow

46/21 Violet/Blue Blue/Violet

47/22 Violet/Orange Orange/Violet

48/23 Violet/Green Green/Violet

49/24 Violet/Brown Brown/Violet

50/25 Violet/Slate Slate/Violet

Table 13
Color code for 25 pair cable  (Part 2 of 2)

Amphenol pin number
Tip Ring

Body/Band Body/Band
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Install small system cabinet wiring to the MDF
Consult the work order to determine the small system cabinet-to-MDF 
cabling route, then perform the steps in Table 14 on page 46:

Figure 14
Option 11 MDF details
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Install Option 11C Mini expander chassis
For information on installing an Option 11C Mini expander chassis, refer to 
Option 11C Mini Planning and Installation (553-3021-209).

Install Succession CSE 1000 Media Gateway Expansion
For information on installing a Succession CSE 1000 Media Gateway 
Expansion, refer to Succession CSE 1000 – Installation and Configuration 
Guide (553-3023-210).

Table 14
Install small system cabinet wiring to the MDF

Step Act ion

1 Identify the UTP Cat 5 twenty five pair MDF cable.

Label both ends of the cable with the cabinet jack number.

2 Connect the cabinet end of the cable.

Insert the cable’s Amphenol connector into the appropriate cabinet connector jack.

3 Run the cable to the MDF.

4 Terminate the cable on the MDF.

For BIX MDF, refer to Figure 14 on page 45 to locate the BIX connectors and Table 13 
on page 43 to locate the cable color code. 

END
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Install DMC8 and faceplate cables
Contents

This chapter contains information on the following topics:

Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Cross-connect base stations to the DMC8 positions. . . . . . . . . . . . . . . . 50

Cross-connect base stations to the DMC8 Relay card. .  . . . . . . . . . . . . 53

Install DMC8 and DMC8-E in an IPE shelf (Option 51C to 81C). . . . . 55

Install DMC8-E in Option 11C, Option 11 Mini, or 
Succession CSE 1000      . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Install faceplate cables and inter-shelf/cabinet cable. .  . . . . . . . . . . . . . 69

Reference list
The following are the references in this section:

• System Installation Procedures (553-3001-210)

• Option 11C Planning and Installation (553-3021-210)

• DECT Overview (553-3601-103)

Compatibility
The NTCW00AB DMC8 and NTCW01AB DMC8-E cards are compatible 
with the following Meridian 1 software releases:

• Release 23 and later supports basic configuration, CLID and CPND, 
DECT card addressing within OA&M, 16 users per card.
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• Release 24B and later supports 32 users per card.

• Release 25 and later supports MSMN and Concentration.

Cross-connect base stations to the DMC8 positions
Consult the work order to determine the cross-connect details and perform the 
following steps:  

CAUTION:  Service interruption
The jumper wire on the MDF must be at least UTP Cat 3. UTP Cat 5 is 
recommended as it provides a greater line length before signal degradation 
occurs.

Table 15
Cross-connect base stations to the DMC8 positions

Step Act ion

1 Cross-connect from the base station house side connector to the DMC8 equipment 
side connector.

Connect a jumper wire from the tip and ring of the house side connector to the tip and 
ring of the equipment side connector. Refer to Table 16 on page 49 for the tip and ring 
designators. For DMC8s type NTCW00AB and NTCW01AB, connect from base station 
1 to base station 8.

Note:  To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules, 
use 24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 from 
16 pair to 24 pair, see System Installation Procedures (553-3001-210), Appendix C.

2 Cross-connect the remaining base stations.

Repeat step one until all base stations are cross-connected. 

END
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Note: The BIX tip and ring connections shown in Table 2 correspond to 
standard BIX designation. The first pair are labeled T0 and R0. See 
System Installation Procedures (553-3001-210), section Planning and 
Designating the MDF.

Table 16
Base station tip and ring connections  (Part 1 of 2)

 Base station number 
Base station MDF 

connection
DMC8 MDF connection

Base station 1 T8 T8

Base station 1 R8 R8

Base station 1 T9 T9

Base station 1 R9 R9

Base station 2 T10 T10

Base station 2 R10 R10

Base station 2 T11 T11

Base station 2 R11 R11

Base station 3 T12 T12

Base station 3 R12 R12

Base station 3 T13 T13

Base station 3 R13 R13

Base station 4 T14 T14

Base station 4 R14 R14

Base station 4 T15 T15

Base station 4 R15 R15

Base station 5 T16 T16

Base station 5 R16  R16

Base station 5 T17  T17

Base station 5 R17  R17

Base station 6 T18  T18
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Base station 6 R18  R18

Base station 6 T19  T19

Base station 6  R19  R19

Base station 7 T20  T20

Base station 7 R20  R20

Base station 7 T21  T21

Base station 7 R2  R21

Base station 8 T22  T22

Base station 8 R22  R22

Base station 8 T23  T23

Base station 8 R23  R23

Table 16
Base station tip and ring connections  (Part 2 of 2)

 Base station number 
Base station MDF 

connection
DMC8 MDF connection
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Cross-connect base stations to the
DMC8 Relay card

Consult the work order to determine the cross-connect details, then perform 
the steps in Table 18 on page 52.

Figure 17
DMC8 Relay card to base station connections

 

NTCW12DA
Ethernet cable

P1 Backplane 

P2 MDF

connector

connector

Base station

DMC8 Relay card

House side 

UTP CAT 5 
MDF cable

Equipment side
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Table 18
Cross-connect base stations to the DMC8 positions 

Step Act ion

1 Connect the NTCW12DA cable to the DMC8 Relay card.

Insert P1 into the DMC8 Relay card backplane connector located on the Meridian 1 
PBX shelf/module or the Option 11C cabinet.

2 Connect the MDF cable to the NTCW12DA cable.

Insert the MDF cable connector into P2.

3 Connect the MDF cable to the equipment side MDF cross-connect terminal block.

See System Installation Procedures (553-3001-210) section “Cabling lines and 
trunks”, or Option 11C Planning and Installation (553-3021-210), section “Installing 
and connecting cross-connect terminal to cabinets”.

4 Cross-connect from the base station house-side connector to the DMC8 Relay card 
equipment side connector.

Connect a jumper wire from the tip and ring of the house-side connector to the tip and 
ring of the equipment-side connector. Refer to Table 16 on page 49 for the tip and ring 
designators. For DMC8s, type NTCW00AB and NTCW01AB connect from base station 
1 to base station 8.

To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE modules requires 
24 tip and ring pair backplane to I/O panel connections. To re-cable NT8D37 from 16 
pair to 24 pair, see System Installation Procedures (553-3001-210), Appendix C.

END
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Install DMC8 and DMC8-E in an IPE shelf (Option 51C to 
81C)

Refer to the work order and marked-up floor plan to determine the position of 
the DMC8 and DMC8-E, then perform the steps in Table 20 on page 55.

  

  

Note 1:  Install the DMC8s next to each other so the faceplate cables 
connect to the ports.

Note 2:  See DECT Overview (553-3601-103), section “System 
software parameters” for DMC8 and DMC8-E software package 
compatibility.

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                         

CAUTION:  Electrostatic sensitive device
Wear a properly connected antistatic wrist strap to handle circuit cards. Only 
touch the edges. Do not touch the contacts or components. Set the cards on 
a protective antistatic bag, whenever possible. If an antistatic bag is not 
available, hand-hold the card, or set it in a card cage removed from the 
connectors.

CAUTION:  Service interruption
Only install DMC8-Es in slot 8.
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Figure 19
DMC8/DMC8-E jumper details

See page 59 for Option 11C card jumper settings.

CAUTION:  Service interruption
Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9 are in the 
ETH position for operation on a dedicated LAN.

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9 are in the 
V.24 position for operation on a serial connection to the OTM server.
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Table 20
Install DMC8 and DMC8-E in an IPE shelf (Option 51C to 81C)

Step Act ion

1 Install J1 jumper straps on the DMC8 and the DMC8-Es for Card ID.

For pre-Release 23 software, strap A B. For post-Release 23 software, and Multi-Site 
Mobility Networking, strap B C.

2 Install J2 jumper straps on the DMC8 and the DMC8-Es for the system type.

Strap A B for IPE shelf. (See Table 22 on page 58 for Option 11C settings.)

3 Install J3 jumper straps on the DMC8 and the DMC8-Es for cabinet or IPE shelf 
number.

For shelf 0, the lower TN IPE shelf, strap B C. For shelf 1, the higher TN IPE shelf, 
strap A B.

4 Install J6 to J9 jumper straps on the DMC8 and the DMC8-Es used as the Relay card 
for either V.24 connection or Ethernet connection.

For the V.24 connection strap jumpers J6 to J9 to the V24 position. For the Ethernet 
connection strap jumpers J6 to J9 to the ETH position. 

5 Insert DMC8-E(s), if required.

Place DMC8-E(s) in slot 8. See examples in Figure 18, Figure 19, Figure 20, and 
Figure 21.

6 Insert DMC(s).

Place DMC8s in the slots as indicated on the work order. Do not place DMC8s in slot 8. 
See examples in Figure 18, Figure 19, Figure 20, and Figure 21. 

END
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Install DMC8-E in Option 11C, Option 11 Mini, 
or Succession CSE 1000

Consult the work order and marked-up floor plan to determine the position of 
the DMC8 and DMC8-Es, then perform the steps in Table 22 on page 58.

Note 1: The DMC8s must be adjacent to each other so the faceplate 
cables can be connected to the ports.

Note 2:  See DECT Overview (553-3601-103) section “System software 
parameters” for DMC8 and DMC8-E software package compatibility.

CAUTION:  Electrostatic sensitive device
Wear a properly connected antistatic wrist strap when handling circuit cards. 
Handle cards by the edges only. Do not touch the contacts or components. 
Set the cards on a protective antistatic bag, whenever possible. If an antistatic 
bag is not available, hand-hold the card, or set it in a card cage unseated from 
the connectors.

CAUTION:  Service interruption
Do not install DMC8-Es into any slot except slots 9, 19, or 29.
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Figure 21
DMC8/DMC8-E jumper details

See page 56 for Option 51C to 81C card jumper settings. 

CAUTION:  Service interruption
Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9 are in the 
ETH position for operation on a dedicated LAN.

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9 are in the 
V.24 position for operation on a serial connection to the OTM server.
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Table 22
Install DMC8-E in an Option 11C cabinet, Option 11C Mini cabinet, Succession CSE 1000 
Media Gateway, or Succession CSE 1000 Media Gateway Expansion

Step Act ion

1 Install J1 jumper straps on the DMC8 and the DMC8-Es for Card ID.

For pre Release 23 software strap A B. For post Release 23 software, and Multi-Site 
Mobility Networking, strap B C.

2 Install J2 jumper straps on the DMC8 and the DMC8-Es for system type.

Strap B C for Option 11C, 11C Mini, Media Gateway, or Media Gateway Expansion. 
(See page 56 for Option 51C to 81C settings.)

3 Install J3 jumper straps on the DMC8 and the DMC8-Es for shelf number.

For the lower TN cabinet, strap B C. For the higher TN cabinet, 
strap A B.

4 Insert DMC8-E(s), if required.

Place DMC8-E(s) in slot 9, slot 19 or slot 29. See examples in Figure 22, Figure 23, 
Figure 24, and Figure 25.

5 Install J6 to J9 jumper straps on the DMC8 and the DMC8-Es used as the Relay card 
for either V.24 connection or Ethernet connection.

For the V.24 connection strap jumpers J6 to J9 to the V24 position. For the Ethernet 
connection strap jumpers J6 to J9 to the ETH position. 

6 Insert DMC8(s).

Place DMC8s in the slots as indicated on the work order. Do not place DMC8s in slot 
9, slot 19 or slot 29. See examples in Figure 22, Figure 23, Figure 24, and Figure 25. 

END
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Figure 23
Example of a full system housed in two IPE shelves
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Figure 24
Example of a 16 card system housed in two IPE shelves
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Figure 25
Example of a 17 card system housed in two IPE shelves
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Figure 26
Example of an eight card system housed in one IPE shelf
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Figure 27
Example of a full Option 11C system not using a CPU cabinet
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Figure 28
Example of a full Option 11C system using a CPU cabinet
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Figure 29
Example of an eight card system in two Option 11C cabinets

Figure 30
Example of an eight card system in one Option 11C cabinet
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Option 11C Mini
For information on installing circuit cards in an Option 11C Mini, refer to 
Option 11C Planning and Installation (553-3021-210).

Figure 31
Option 11C MIni main and expander chassis connected with the two NTDK95 and 
CE-MUX/DS-30SX bus cables 

DS-30X connection
CE-MUX
connection
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Figure 32
Succession CSE 1000 Media Gateway and Media Gateway Expansion cabling

Install faceplate cables and inter-shelf/cabinet cable
Consult the work order to determine the position of the faceplate cable layout 
and NTCW11EA DMC8-E to DMC8-E inter-shelf cables, then perform the 
steps in Table 6 on page 71.

DS-30X
connection

CE-MUX
connection
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Figure 33
NTCW11EA DMC8-E to DMC8-E faceplate cable 

CAUTION
Service Interruption

The NTCW11EA DMC8-E to DMC8-E faceplate cable has four sets of 
movable ferrites. The position of the ferrites on the cable is important. See 
Figure 28. 

Each end of the cable must have a group of 20 ferrites. One quarter of the 
distance from each end of the cable must have a group of 10 ferrites. The 
maximum length of the cable is 1.5 meters, limiting the position of DECT 
shelves 0 and 1 to adjacent IPE modules or small system cabinets.

Group of 20
ferrites

Group of 10
ferrites
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Consult the work order to determine the position of the terminator plugs, then 
perform the following steps:

Table 34
Install faceplate cables and inter-shelf/cabinet cable

Step Act ion

1 Connect the DMC8 to DMC8 faceplate cables.

Arrange the NTCW11AA DMC8 to DMC8 cables so that the DMC8 to DMC8-E cable is 
connected into the ports shown in Figures 18 to 20.

2 If required, connect the NTCW11BA DMC8 to DMC8-E cable on the IPE shelf. Not 
required on Option 11C.

Plug the cable into the lower port of the DMC8 in slot 7. Plug the other end of the cable 
into the arrow pointing left port of the DMC8-E in slot 8. See Figure 18, Figure 19, and 
Figure 20.

3 Connect the NTCW11EA DMC8-E to DMC8-E inter-IPE shelf or inter-cabinet cable, if 
required.

Plug the DMC8-E to DMC8-E cable into each DMC8-E lower port. 

END
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78
Install OTM DECT application
Contents

This chapter contains information on the following topics:

Ensure the DECT application is on the OTM server. .  . . . . . . . . . . . . . 72
Ensure a Communications Profile is associated with the DECT 
application. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Add a Communications Profile for the DECT application. .  . . . . . . 75
Add an Ethernet profile. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Reference list
The following are the references in this section:

• Installing and Configuring Optivity Telephony Manager (553-3001-230)

This Installation Guide assumes that an Optivity Telephony Manager (OTM) 
server is installed on the PBX.

If the OTM is not installed, follow the instructions in Installing and 
Configuring Optivity Telephony Manager (553-3001-230) to install it.
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Ensure the DECT application is on the OTM server

Figure 35
Applications to Re-install

Complete the following steps:

Table 1
Ensure the DECT application is on the OTM server

Step Act ion

1 If there is a check in the DECT box in the Applications to Re-install dialog.

Go to “Configure the DECT system on the OTM server” on page 79.

2 If there is no check in the DECT box in the Applications to Re-install dialog. 

Note:  Installation is like any other application.

Select the check-box and click on the Next button. 

END
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Ensure a Communications Profile is associated
with the DECT application 

The DECT application must be associated with a Communications Profile. 

Figure 36
Systems Properties – Applications

The following describes the OK, Cancel, and Apply button actions:

• OK adds the changes that were made, then returns to the previous screen.

• Apply adds the changes and leaves the properties open so that other 
information can be added to this properties dialog.

• Cancel closes the dialog box without adding the changes.
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Complete the following steps:

Table 2
Ensure a Communications Profile is associated with the DECT application

Step Act ion

1 Open the Systems Properties sheet.

Choose Properties from the OTM Navigator window File menu.

2 Select the Applications tab.

Click on the Applications tab.

3 If there is a check in the Enabled column next to DECT in the Name column. 

Go to “Configure the DECT system on the OTM server” on page 79. 

4 If there is no check in the Enabled column next to DECT in the Name column.

Highlight DECT in the name column.

5 Select a Communication Profile.

Choose any entry from the Communication Profile drop-down list.

Note:  If there are no entries in the Communication Profile drop-down list, go to “Add a 
Communications Profile for the DECT application” on page 75.

6 Accept the changes.

Click the OK button.

END
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Add a Communications Profile for the DECT application

Figure 37
Add Communications Profile
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Complete the following steps:

Table 3
Add new Meridian 1 PBX Communications Profile 

Step Act ion

1 In the Navigator window, select the Sample Site.

Double click on Sample Site.

2 Choose the Properties dialog.

Click on Properties from the File menu.

3 Open the Add Communications Profile dialog.

Click on the Communications tap and click Add.

4 Select a communications type.

Highlight Ethernet in the Type box.

Note:  The DECT application does not use the Communications Profile. Unless there is 
another application that requires a specific Communications Profile, choosing Ethernet 
is the least complicated profile to implement.

5 Program the Profile Name.

Enter a Profile Name.

6 Accept the changes.

Click OK.

END
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Add an Ethernet profile

Figure 38
System Properties – Communications
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Complete the following steps:

Table 4
Add the Meridian 1 PBX Ethernet profile

Step Act ion

1 Fill in the communications information for the Ethernet profile.

Enter any IP address.

Note:  Unless there is another application that requires a specific IP address, enter a 
non-existing address.

2 Accept changes.

Click Apply.

3 Return to configuring a communications profile.

Go to “Ensure a Communications Profile is associated with the DECT application” on 
page 73.

END
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100
Configure the DECT system 
on the OTM server
Contents

This chapter contains information on the following topics:

Install the DME on the DMC8 Relay card. . . . . . . . . . . . . . . . . . . . . . . 80

Change the DMC8 Relay card default IP address. .. . . . . . . . . . . . . . . . 81
Connect the DMC8 Relay card to a configuring PC. .  . . . . . . . . . . . 81
Reset the DMC8 Relay card default IP address to the LAN IP address. . 84

Connect the DMC8 Relay card to the OTM server. .  . . . . . . . . . . . . . . 86

Launch the DECT application. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Add the DECT system. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Add General System Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Set the DECT system IP address to match the DMC8 Relay card. .. 91
Add the upstream manager IP address, if required. .  . . . . . . . . . . . . 93

Synchronize data with the DECT system. . . . . . . . . . . . . . . . . . . . . . . . 94
Synchronize DECT PARI and SARI. . . . . . . . . . . . . . . . . . . . . . . . . 97
Synchronize DECT parameters. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Synchronize DECT Upstream Manager IP address. . . . . . . . . . . . . . 99
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Install the DME on the DMC8 Relay card

Figure 39
NTCW25AA DECT Manager Ethernet (DME) daughterboard location 

The NTFZ38AA Ethernet Management Connection package is available, 
containing the following:

• one NTCW25AA DECT Mobility Ethernet (DME) card

• one NTCW12DA DMC8 I/O cable
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Change the DMC8 Relay card default IP address

Connect the DMC8 Relay card to a configuring PC

Table 5
Install the DME on the DMC8 Relay card

Step Act ion

1 Unpack the NTCW25AA DECT Manager Ethernet (DME) daughterboard.

Remove the packing material.

2 Install the DME.

Carefully position the daughterboard over the four standoff posts and press onto the 
DMC8 relay card.

CAUTION:  Service interruption
The DMC8 is shipped with a default IP address 192.168.1.1. The default 
address must be changed to conform to the network IP address plan.

END
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Figure 40
NTCW12DA Ethernet cable to configuring PC connections

For information on connecting OTM through a V.24 serial connection, see 
“Add a V.24 serial connection” on page 135.

Note: The configuring PC can be the OTM server or another PC.
If the configuring PC is the OTM server, the Captive LAN shown in 
Figure 40 will be the OTM Server Dedicated LAN shown in 
Figure 42 on page 86.

Captive LAN

DMC8 Relay card

NTCW12DA Ethernet cable

Configuring PC

P1 Shelf/Cabinet

P2 MDF connector

Backplane connector

P3 Ethernet
connector

DECT System

RJ-45
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Consult the work order to determine the DMC8 Relay card location, then 
perform the steps in Table 6 on page 83.

Note: The Relay card can be any of the DMC 8 or DMC8-E cards. 
Usually, the lowest-numbered card is used.

Table 6
Connect the DMC8 Relay card to a configuring PC

Step Act ion

1 Connect the NTCW12DA cable to the connector on the backplane of the DMC8 Relay 
card.

Insert P1 into the DMC8 Relay card backplane connector located on the Meridian 1 
PBX shelf/module or the Option 11C cabinet. 

2 If the Configuring PC is on a captive LAN, link the DMC8 Relay card to the Configuring 
PC.

Insert P3 into the captive LAN RJ-45 connector.

3 If the Configuring PC is on the OTM server dedicated LAN,

Insert P3 into the OTM server dedicated LAN RJ-45 connector.See “Connect the 
DMC8 Relay card to the OTM server” on page 86. 

END
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Reset the DMC8 Relay card default IP address to 
the LAN IP address

The DMC8 Relay card default IP address 192.168.1.1 must be changed to 
conform to the server network IP address plan.

Figure 41
Telnet 192.168.1.1
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Complete the following steps:  

Table 7
Reset the DMC8 Relay card default IP address to the LAN IP address 

Step Act ion

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the DMC8 Relay card address.

Enter the following command: 
ipconfig xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy zzz.zzz.zzz.zzz

xxx.xxx.xxx.xxx = new IP address of the DMC8 Relay card.

yyy.yyy.yyy.yyy = subnet mask, usually 255.255.255.0

zzz.zzz.zzz.zzz = IP address if this is the gateway for the network.

Note:  zzz.zzz.zzz.zzz should be set to the IP address of the OTM server Ethernet 
interface. If there are two Ethernet interfaces on the OTM server, zzz.zzz.zzz.zzz should 
be set to the IP address of the interface which is on the same network as the DMC8 
Relay card.
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Connect the DMC8 Relay card to the OTM server

Figure 42
NTCW12DA Ethernet cable to OTM Server LAN connections

DECT System

DMC8 Relay card MDF 

OTM Server

Dedicated LAN

RJ-45

NTCW12DA
Ethernet cable

P1 Backplane 

P2 MDF

P3 Ethernet
connector

connector

connector

RJ-45

DMC8 Relay card

MDF
cable
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Complete the following steps:

Table 8
Connect the DMC8 Relay card to a Captive LAN

Step Act ion

1 If the DMC8 Relay card was configured on a captive LAN, remove the NTCW12DA 
Ethernet cable from the captive LAN.

Disconnect P3 from the captive LAN RJ-45 connector.

2 Connect the NTCW12DA cable to the OTM Server Dedicated LAN.

Insert P3 into the Dedicated LAN RJ-45 connector. 
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Launch the DECT application

Figure 43
M1 System Window

Complete the following steps:

Table 9
Launch the DECT application

Step Act ion

1 Launch the DECT application.

Double click on the DECT icon.

END
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Add the DECT system
Add General System Properties

Figure 44
DECT Systems and DECT System Properties 
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Complete the following steps:

Table 10
Add the DECT system

Step Act ion

1 Open the DECT System Properties dialog.

Pull down File>Properties. 

2 Enter the DECT system name.

Type the system name in the DECT System Name box.

3 Accept the changes.

Click on the Apply button.

END
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Set the DECT system IP address to match
the DMC8 Relay card

Figure 45
System Properties – Communication
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Complete the following steps:

Table 11
Set the IP address of the DMC8 Relay card in the manager

Step Act ion

1 Open the Communications dialog.

Click on the Communications tab.

2 Enter the IP address.

Type the IP address that was entered in Table 7 on page 85.

3 If the communication link is Ethernet, select Ethernet.

Click on the Ethernet radio button.

4 If the communication link is Serial, select Serial.

Click on Serial radio button, and go to “Add a V.24 serial connection” on page 135.

5 Accept the changes.

Click on the OK button.

Note:  When the OK button or Apply button is clicked at this point, the manager attempts 
to connect to the DECT system to write the MIB2 system name. 

6 If required, program an Upstream Manager.

Go to page 93.

7 If an Upstream Manager is not required.

Go to “Synchronize data with the DECT system” on page 94.

END
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Add the upstream manager IP address, if required

Figure 46
System Properties – Alarm
DECT Installation Guide



Page 94 of 222  Configure the DECT system on the OTM server
Complete the following steps:

Synchronize data with the DECT system
When the DECT manager connects to the DECT system, synchronization 
occurs. Synchronization compares the database on the manager to the 
database of the DECT system. Database mismatches are flagged by dialogs. 
The opportunity to change either the DECT system data or the manager data 
is given.

Table 12
Add the upstream IP address, if required

Step Act ion

1 Open the DECT System Properties dialog.

Pull down File>Add. 

2 Open the Alarm dialog.

Click on the Alarm tab.

3 Enter the IP address.

Type the Upstream manager IP address.

4 Accept the changes.

Click on the OK button. 

END
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Figure 47
DECT Systems
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Complete the following steps:

Table 13
Synchronize data with the DECT system 

Step Act ion

1 If the toolbar icon is red, the connection to the DECT system is enabled. Disconnect 
from the DECT system.

Double click on the icon, or use File>Disonnect. Go to “Synchronize DECT PARI and 
SARI” on page 97.

2 If the toolbar icon is green, re-connect to the DECT system

Double click on the red icon, or use File>Connect.

END
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Synchronize DECT PARI and SARI

Figure 48
Synchronize DECT PARI and SARI Mismatch dialog

Complete the following step:

Table 14
Synchronize DECT PARI and SARI 

Step Act ion

1 Store the DECT system PARI SARI parameters in the OTM Manager database.

Click on the Update DECT Manager button.

END
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Synchronize DECT parameters

Figure 49
Synchronize DECT Parameters Mismatch dialog

Complete the following step:

Table 15
Synchronize DECT Parameters

Step Act ion

1 Store the DECT system DECT Parameters in the OTM Manager database.

Click on the Update DECT Manager button.

END
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Synchronize DECT Upstream Manager IP address

Figure 50
Synchronize DECT Upstream Manager IP address mismatch dialog

Complete the following step:

Table 16
Synchronize DECT Upstream Manager IP address 

Step Act ion

1 Store the DECT system Upstream Manager IP address in the OTM Manager database.

Click on the Update DECT Manager button.

END
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102
Un-installing DECT Manager – Caution
Before un-installing DECT Manager, read the following information.

CAUTION:  Service interruption

When the OTM DECT Manager is un-installed, the Sentinel driver is 
also un-installed, even if other applications require the driver. Any 
attempt to launch other OTM systems or applications generates the 
message

           “No dongle attached to the PC.”

It is necessary to re-install the Sentinel driver. Download the driver 
from the internet.
Go to www.rainbow.com.tech/downloads.html

In the product drop-down menu, scroll down and select System 
Drivers.

On the System Drivers page, select the Sentinel System Driver – 
Driver Only file and download the zipped file. After download is 
complete, unzip the file and install the driver.
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128
Configure handsets and retrieve
subscription data 
Contents
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Configure non-concentrated handsets on a Meridian 1 PBX
For information about System Administration, see Using Optivity Telephony 
Manager (553-3001-330).

Open Station Administration window

Figure 51
M1 System Window

Table 17
Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M1 System Window.

END
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Access Add Station dialog

Figure 52
Station Administration window

Complete the following step:

Table 18
Access Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.

END
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Add 500 analog standard

Figure 53
Add Station dialog

Complete the following step:

Table 19
Add 500 analog standard

Step Action

1 Add 500 analog standard.

Highlight 500 Analog Standard, and click OK.

END
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Access features

Figure 54
500 dialog

Complete the following step:

Table 20
Access features

Step Action

1 Access the features.

Click on the Features button.

END
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Access wireless type

Figure 55
Features dialog

Complete the following step:

Table 21
Access wireless type

Step Action

1 Access wireless type.

Highlight Wireless Type, and click on the Select button.

END
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Select wireless type

Figure 56
Wireless dialog

Complete the following step:

Table 22
Select wireless type

Step Action

1 Select wireless type.

From the Wireless Type (WTYP) pull-down menu select YES.

END
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Select DECT wireless set

Figure 57
Wireless dialog

Complete the following step:

Table 23
Select DECT wireless set

Step Action

1 Select DECT handset.

From the Wireless Type (WTYP) pull-down menu, click on DECT Wireless Set. Click  
OK.

END
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Accept changes

Figure 58
Features dialog

Complete the following step:

Table 24
Accept changes

Step Action

1 Accept changes.

Click on the Done button.

END
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Configure concentrated handsets on a Meridian 1 PBX
Open Station Administration window

Figure 59
M1 System Window

Complete the following step:

Table 25
Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the Meridian 1 System Window.

END
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Access Add Station dialog

Figure 60
Station Administration window

Complete the following step:

Table 26
Access Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.

END
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Select Digital Cordless Set

Figure 61
Add Station dialog

Table 27
Select Digital Cordless Set

Step Action

1 Select Digital Cordless Set.

Highlight DCS. Click on the OK button.
END
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Select Features

Figure 62
DCS dialog
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Select wireless type

Figure 63
Features dialog

Table 28
Select Features

Step Action

1 Select the features.

Click on the Features button.

END
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Select Visiting DECT SET or local calling only

Figure 64
Wireless dialog

Table 29
Select wireless type

Step Action

1 Select wireless type.

Highlight WTYP, and click on the Select button.

END
553-3601-203   Standard 6.00 September  2002



 Configure handsets and retrieve subscription data Page 119 of 222
Table 30
Select Visiting DECT Set or local calling only

Step Action

1 Select Visiting DECT Set  as Yes if the handset is to visit this Meridian 1 PBX. Select 
No if this handset is to be used for local calling only.

If Visiting DECT Set is Yes, go to step 2. If this handset is to be used for local calling 
only, go to step 3.

2 Select a Home DN.

Enter a DN in the Home Directory Number (HMDN) box.

3 If the handset is to be used for local calling only, from the Visiting DECT Set (VSIT) 
list, select No.

4 Accept changes.

Click on the OK button.

END
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Select an index

Figure 65
Features dialog

Table 31
Select an index

Step Action

1 Select an index.

Highlight INDX, and click on the Select button.

END
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Provision hardware

Figure 66
Hardware Provisioning dialog

Table 32
Provision hardware

Step Action

1 Select a DMC TN.

Enter a TN in the DECT Mobility Controller (DMC) box.

2 Select an index.

Enter an index in the Index on DMC (INDX) box. (Index range is 0 to 509.)

Note:  The Terminal Number (TN) is a virtual TN and is selected by the Meridian 1 PBX 
system.

3 Accept changes.

Click the OK button.

END
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Accept changes

Figure 67
Features dialog

Table 33
Accept changes

Step Action

1 Accept changes.

Click on the Done button.

END
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Select Single Line Features

Figure 68
500 dialog

Table 34
Single Line Features

Step Action

1 For information on other Single Line Features.

Refer to the OTM Station Administration in Using Optivity Telephony Manager 
(553-3001-330).

END
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Note: Complete the DECT Programming and Provisioning Record 
(553-3601-250).

Retrieve subscription data for handsets

Figure 69
DECT Systems window and Subscriptions window
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Complete the following steps:

Table 35
Subscribe handsets

Step Act ion

1 Launch the Subscriptions window from the DECT Systems window.

Click on the Applications pull-down menu, click on Subscriptions.

2 Retrieve the subscription configuration data from the OTM Station Administration 
database.

Note:  At this point, no handset data appears in the Subscriptions window.

In the Subscriptions window, click on the Operations pull-down menu, click on 
Retrieve OTM Configuration.

3 Open the Configure DECT Subscription dialog.

Note:  At this point, all handsets configured on OTM Station Administration are shown 
in the Subscriptions window

Click on the File pull-down menu, click on Add or click on .

END
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Enable subscription

Figure 70
Subscriptions window 

Complete the following steps for each handset:

Table 36
Configure handsets

Step Act ion

1 Note:  At this point, there are no PINs shown in the Subscriptions window.

Select a handset from the list.

Click on one handset in the list to highlight a row.

2 Enable handsets.

Click on the Operations pull-down menu, click on Enable or click on .

END
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Activate the PIN on the handsets

Figure 71
Subscriptions window

Complete the following steps:

Note: When a handset is subscribed, the Subscription window shows the 
Status column as Subscribed and does not show a PIN.

Table 37
Obtain the PIN

Step Act ion

1 Note:  At this point, in the Subscriptions window, the PINs are shown and the Status is 
Enabled.

Subscribe the DECT handsets.

See “Handset subscription” on page 128.

Enabled

END
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Handset subscription
For detailed information on subscribing a handset, refer to “DECT system 
administration” in DECT Operation Administration and Maintenance  
(553-3601-301), or the individual handset’s User Guide.
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134
Base Station Power and Muting
Contents

This chapter contains information on the following topics:

Open RFP window. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Set alarm muting, line power, and comments for base stations. . . . . 132
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Open RFP window

Figure 72
DECT Systems main window and RFP window
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Complete the following steps:

Table 38
Open RFP window

Step Act ion

1 Launch the DECT Systems window.

2 Launch the Boards window.

On the DECT Systems window, click on the Applications pull-down menu, click on 
Boards.

3 Select a base station from the list.

Click on one RFP in the list to highlight a row.

4 Open the Radio Fixed Part properties dialog.

Click on the File pull-down menu, click on Properties.

END
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Set alarm muting, line power, and comments
for base stations

Figure 73
DECT Radio Fixed Parts
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Complete the following steps:

Table 39
Set alarm muting, line power, and comments for base stations

Step Act ion

1 Set alarm muting. Select No to deny alarm muting or Yes to allow alarm muting.

Click on No or Yes.

2 Enter up to 80 characters for comments.

Type comments.

3 Select local powered or line powered for the selected base station.

Click the Line Powered or Local Powered radio button.

4 Apply the selections.

Click the OK button.

END
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194
Add a V.24 serial connection
Contents

This chapter contains information on the following topics:

DMC8 to OTM server serial connections . . . . . . . . . . . . . . . . . . . . . . . . . 136
Serial connection for Windows 2000. . . . . . . . . . . . . . . . . . . . . . . . . 137
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Establish the RAS connection. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
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Reference list
The following are the references in this section:

• System Installation Procedures (553-3001-210)

DMC8 to OTM server serial connections
A DMC8 Relay card-to-OTM server serial connection is required if a DME 
daughterboard is not present on the relay card. There are two types of serial 
connections:

• when the relay card and OTM server are local, and connected without a 
modem

• when the relay card and OTM server are remote, and connected with a 
modem

CAUTION:  Service interruption
Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9 are in the 
V.24 position for operation on a serial connection to the OTM server.
553-3601-203   Standard 6.00 September  2002



 Add a V.24 serial connection Page 137 of 222
Serial connection for Windows 2000
For information on how to configure a serial connection using Windows 
2000, see “V.24 connection using Windows 2000” on page 175.

Connect the Relay card to a local OTM server 
without a modem

Figure 74
DMC8 Relay card connection to a local OTM server without a modem

DMC8 Relay card
without NTCW25AA
DME daughterboard

OTM Server

 NTCW12AA
MDF to modem
      cable

 A0773252
Null modem
   adaptor

 Standard
DB-25 to DB-9
      cable
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Note: The BIX tip and ring connections shown in Table 41 on page 138 
correspond to standard BIX designation. The first pair are labeled T0 and 
R0. See System Installation Procedures (553-3001-210), section 
Planning and Designating the MDF.

Table 40
Connect the Relay card to a local OTM server 

Step Act ion

1 Connect the NTCW12AA cable to the DMC8 Relay card MDF connector.

Refer to Table 41 on page 138 for the NTCW12AA cable tip and ring connections.

2 Choose the OTM server COM port from the work order.

Connect the DB-9 cable connector into the OTM COM port.

3 Install the null modem plug.

Connect the DB-25 connector end and the NTCW12AA cable end into the AO773252 
null modem adapter.

Table 41
NTCW12AA cable to MDF connections

DMC8 Relay card 
MDF connection

Cable color
DB25 connector pin 

number
Signal designator

T1 Grey 8 V.24DCD

R2 Yellow 4 V.24RTS

T3 Blue 2 V.24TXD

R3 Red 3 V.24RXD

T4 Pink 7 V.24GND

END
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Connect the relay card to a remote OTM server with 
modems

Figure 75
DMC8 relay card connection to a remote OTM server

Table 42
Connect the remote OTM server to a modem  (Part 1 of 2)

Step Act ion

1 Connect the OTM COM port to the modem.

Connect the DB-9 end of the V.24 cable to the OTM COM port. Connect the DB-25 end 
of the V.24 cable to the modem.

DMC8 Relay card
without NTCW25AA
DME daughterboard

OTM Server

 NTCW12AA
MDF to modem
      cable

 Standard
DB-25 to DB-9
      cable

 

Modem
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2 Set up the OTM modem.

Follow the manufacturers set-up procedures. Set modem as follows:

• Line speed = 38400b/s

• No parity

• 1 stop bit

• 8 bit words

• No output control

• No timer

3 Connect the modem to the Public Switched Telephone Network.

Plug a teledapt cable into the modem RJ-11 jack. Connect the other end of the teledapt 
cable to the PSTN.

Table 43
Connect the DMC8 Relay card to a modem  (Part 1 of 2)

Step Act ion

1 Connect the NTCW12AA cable to the DMC8 Relay card MDF connector.

Refer to Table 41 on page 138 for the NTCW12AA cable tip and ring connections.

2 Set up the OTM modem.

Table 42
Connect the remote OTM server to a modem  (Part 2 of 2)

Step Act ion

END
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Follow the manufacturers set-up procedures. Set modem as follows:

• Line speed = 38400b/s

• No parity

• 1 stop bit

• 8 bit words

• No output control

• No timer

3 Connect the NTCW12AA cable to the modem.

4 Connect the OTM modem to the Public Switched Telephone Network (PSTN).

Plug a teledapt cable into the modem RJ11 jack. Connect the other end of the teledapt 
cable to the PSTN.

Table 43
Connect the DMC8 Relay card to a modem  (Part 2 of 2)

Step Act ion

END
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Install a virtual modem on the PC
A virtual modem is required for a local serial connection.

Figure 76
Install New Modem
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Complete the following steps:

Table 44
Install a modem on the PC 

Step Act ion

1 Go to Control Panel.

Click on Modem.

2 In the Manufacturers field.

Select [Standard Modem Types].

3 In the Models field.

Select Dial-Up Networking Serial Cable between 2 PCs.

4 Continue.

Click on Next.

END
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Configure modem properties
The properties must be configured to interface serially to the DECT system.

Figure 77
Modem Properties
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Complete the following steps:

Table 45
Configure modem properties 

Step Act ion

1 Go to Control Panel.

Click on Modem.

2 Select the modem installed.

Click on the modem in the list.

3 Open the properties dialog.

Click the Properties button.

END
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Set modem speed 

Figure 78
Dial-Up Networking Serial Cable between 2PCs #... General tab

Complete the following steps:

Table 46
Set modem speed

Step Act ion

1 Select maximum modem speed.

Choose 38400.

2 Apply selection.

Click OK.

END
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Set connection preferences

Figure 79
Dial-Up Networking Serial Cable between 2PCs #... Connection tab 
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Complete the following steps:

Table 47
Set connection preferences 

Step Act ion

1 Set Data bits.

Select 8.

2 Set Parity.

Select None.

3 Set Stop bits

Select 1.

4 Open Advanced dialog.

Click on the Advanced button.

END
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Disable flow control

Figure 80
Advanced Connection Settings 

Complete the following step:

Table 48
Disable flow control

Step Act ion

1 Ensure that flow control is disabled.

Remove check from the Use flow control box.

END
DECT Installation Guide



Page 150 of 222  Add a V.24 serial connection
Configure Remote Access Service (RAS)

Figure 81
Network – Services
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Complete the following steps:

Table 49
Configure Remote Access Service

Step Act ion

1 Open the Network property dialog.

Start> Control Panel> click on the network icon.

2 Select Services.

Click on Services tab.

3 Select the Remote Access Service.

Click on Remote Access Service.

END
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Set RAS modem and port usage

Figure 82
Remote Access Setup and Configure Port Usage

Complete the following steps:

Table 50
Set modem and port usage  (Part 1 of 2)

Step Act ion

1 Select a modem.

Highlight a device.

2 Configure.

Click on the Configure... button.
553-3601-203   Standard 6.00 September  2002



 Add a V.24 serial connection Page 153 of 222
Configure RAS setup and network

Figure 83
Remote Access Setup and Network Configuration

3 Select Port Usage.

Click on the Dial out only radio button.

Table 50
Set modem and port usage  (Part 2 of 2)

Step Act ion

END
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Complete the following steps:

Table 51
Configure Remote Access Service 

Step Act ion

1 Select a modem.

Highlight a device.

2 Select Network.

Click on the Network button.

3 Select TCP/IP protocol for this port.

Click a check in the TCP/IP box.

END
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Configure NetBIOS services
The NetBIOS Interface Service must be installed. If this is not done, there will 
be no PPP protocols configured on the RAS ports.

Figure 84
Network – Services
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Complete the following steps:

Table 52
Configure Remote Access Service  

Step Act ion

1 Ensure that the NetBIOS Interface Service is installed.

Double-click on the Control Panel’s Network and Dial-up Connections icon. Right-click 
on the appropriate connection. Click Properties. Click the Services tab.

2 Observe if the NetBIOS Interface is on the list of Network Services.

If the NetBIOS Interface is on the list of Network Services, click Close. Go to “Set up 
and configure a RAS Phone book entry” on page 157.
If the NetBIOS Interface is not on the list of Network Services, click Add. 
See Figure 84.

3 The Select Network Component appears. Select the required network component.

Select Protocol. Click Add

4 The Select Network Protocol window opens. Select the desired protocol.

Select NetBIOS Interface. Click Install. Click Close. 

END
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Set up and configure a RAS Phone book entry

Open the Dial-up Networking dialog

Figure 85
Dial-up Networking dialog 

Complete the following steps:

Table 53
Open the Dial-up Networking dialog  (Part 1 of 2)

Step Act ion

1 Open the Dial-up Networking property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.
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Set up the phone book entry name

Figure 86
New Phonebook Entry Wizard 

2 Continue.

Press the New button.

Table 53
Open the Dial-up Networking dialog  (Part 2 of 2)

Step Act ion

END
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Complete the following steps:

Table 54
Set up the phone book entry name

Step Act ion

1 Name the phone book entry.

Enter the system name.

2 Accept the changes.

Press the Next button.

END
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Set up the server dialog

Figure 87
Server 

Complete the following steps:

Table 55
Configure Remote Access Service

Step Act ion

1 Set up the server dialog.

Check the Send my plain text password... box.

2 Accept the changes.

Press the Next button.

END
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Go to the next dialog

Figure 88
Phone Number 

Complete the following step:

Table 56
Go to the next dialog

Step Act ion

1 Omit this dialog.

Press the Next button.

END
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Set up complete

Figure 89
New Phonebook Entry Wizard 

Complete the following step:

Table 57
Set up complete

Step Act ion

1 Complete the set up.

Press the Finish button.

END
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Configure the networking dial-up

Figure 90
Dial-Up Networking 

Complete the following steps:

Table 58
Configure the networking dial-up

Step Act ion

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Select edit phone book.

Under the More drop-down list, select Edit entry and modem properties.

END
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Configure the Dial using an entry

Figure 91
Edit Phonebook Entry – Basic 

Complete the following step:

Table 59
Configure the Dial using an entry

Step Act ion

1 Configure an entry from the Dial using drop-down list.

Note:  The list shows modems that were previously configured.

Select an appropriate entry from the Dial using drop-down list.

2 Accept the changes.

Press the OK button.

END
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Configure the Dial-up server type

Figure 92
Edit Phonebook Entry – Server

Complete the following steps:

Table 60
Configure the Dial-up server type

Step Act ion

1 Configure the Dial-up server type.

Select PPP: Windows NT... and check the boxes shown in Figure 92 on page 165.

2 Open the PPP TCP/IP Settings dialog.

Press the TCP/IP settings button.

END
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Configure IP address

Figure 93
PPP TCP/IP Settings 

Complete the following steps:

Table 61
Configure IP address  (Part 1 of 2)

Step Act ion

1 Select the settings.

Click the Specify an IP address and the Server assigned name server address 
radio buttons.
Click on both check boxes.
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Accept the configuration changes

Figure 94
Services

2 Specify an IP address.

Enter the IP address.

Table 61
Configure IP address  (Part 2 of 2)

Step Act ion

END
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Complete the following step:

Establish the RAS connection

Figure 95
Dial-Up Networking 

Table 62
Accept the configuration changes

Step Act ion

1 Accept the configuration changes.

Press the OK button.

END
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Complete the following steps:

Establish a connection to the DECT system

Figure 96
Connect to my DECT system 

Table 63
Establish the RAS connection

Step Act ion

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Select the Phonebook entry to dial.

Highlight the entry.

3 Dial.

Press the Dial button.

END
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Complete the following step:

Establish connection complete

Figure 97
Connection Complete 

Table 64
Establish a connection to the DECT system

Step Act ion

1 Establish access.

Note:  No input to this dialog needed.

Press the OK button.

END
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Complete the following step:

Set the IP address through Telnet

Figure 98
Connect

Table 65
Establish connection complete

Step Act ion

1 Finish.

Press the OK button.

END
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Complete the following steps:

Table 66
Set the IP address through Telnet

Step Act ion

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Telnet.

2 Address the DMC8 Relay card using the card’s default IP address.

Enter 192.168.1.1 in the Host Name: box.

3 Connect to the DMC8 Relay card.

Press the Connect button.

END
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Configure the IP address

Figure 99
Telnet 192.168.1.1 

Complete the following steps:

Table 67
Configure the IP address

Step Act ion

1 Login.

Enter dasuser.

2 Password.

Enter dasuser.

3 Configure the IP address.

Use ipconfig as shown on the bottom line in Figure 99 on page 173.

4 Disconnect the Telnet connection.

Click on the close box in the upper right corner.

END
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Hang-up the RAS connection

Figure 100
Dial-Up networking 

Complete the following steps:

Table 68
Hang up the RAS connection

Step Act ion

1 Hang up the RAS connection.

Click the Hang Up button.

END
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V.24 connection using Windows 2000
For the OTM-DECT Manager to communicate with the DECT system 
remotely over Point-to-Point Protocol (PPP), RAS must be configured for 
dial-out using the appropriate modem. See “Configure Remote Access 
Service (RAS)” on page 150.

Note 1: The DECT system can also directly communicate over a modem 
to a remote OTM-DECT Manager.

Note 2:  The back-end process must be visible to make a connection. See 
“Launch OTM-DECT back-end” on page 191 for more information. If 
the back-end is closed in error, OTM-DECT will not operate.

Dial-up configuration
Configure dial-up on the OTM server using Windows 2000. Perform the 
following steps:

1 Select the Control Panel > Phone and Modem Options > Modems tab.

2 Click Add.

3 Click check box Don’t detect my modem.... Click NEXT.

4 From Manufacturer’s List Type list, select Standard Modem.

5 From Model’s list, select Communications cable between two 
computers. Click Next.

Note: Step 5 is required only if there is no Ethernet connection to the 
DMC8 card.

6 Select a COM port supported by the PC. Click Next.

7 Click Finish.

Modem configuration
Configure the modem properties for serial interface. To configure the 
modem, perform the following steps:

1 Select Control Panel > Phone and Modem Options> Modems tab.

2 Select the modem Communications cable between two computers. 
Click Properties. See Figure 101 on page 176. 
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Figure 101
Control Panel > Phone and Modem Options > Modems tab

3 In the Maximum Port Speed drop-down menu, select 38400. 
See Figure 102 on page 177.
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Figure 102
Modem tab – Properties button 

4 Click the Advanced tab.

5 Set the Data bits to 8. 
Set the Parity bits to None. 
Set the Stop bits to 1.

6 Click OK. 
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Network and dial-up connections configuration

Note: Ensure that the NetBIOS Interface Service is installed; otherwise 
PPP is not configured on the RAS ports.

To configure network and dial-up connections, perform the following steps:

1 Select Control Panel > Network and Dial-up Connections.

2 Click the Make new connection icon. The Connection Wizard starts. 
See Figure 103.

Figure 103
Network Connection Wizard
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3 Click Next.

4 Click the Connect directly to another computer radio button. Click 
Next. See Figure 104 on page 179.

Note: If using a modem connection to the DMC8 card, click the 
Dial up to private network radio button.

Figure 104
Network Connection Type radio buttons

5 Click the Guest radio button. Click Next. See Figure 105 on page 180.
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Figure 105
Host or Guest

6 From the Select a Device drop-down list, select Communications cable 
between two computers. Click Next. See Figure 106 on page 181.
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Figure 106
Select a Device

7 Click the For all users radio button. Click Next. See Figure 107 on page 
182.
DECT Installation Guide



Page 182 of 222  Add a V.24 serial connection
Figure 107
Connection Availability

8 Type a name for the connection. Click Finish. 
See Figure 108 on page 183.
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Figure 108
Completing the Network Connection Wizard

A new window appears automatically. The window is titled with the 
connection name entered earlier. See Figure 109 on page 184.

It is not necessary to enter a user name or password.
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Figure 109
New connection window

9 Click Properties. A new window opens.

10 Select the General tab. Select Communications cable between two 
computers (COM2) from the Select a device drop-down menu. See 
Figure 110 on page 185.
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Figure 110
General tab

11 Click Configure. The Modem Configuration window opens. Ensure that 
the Maximum speed (bps) is 38400 bauds. See Figure 111 on page 186. 
Click OK.
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Figure 111
Modem Configuration window 

12 Select the Security tab. Click the Security Options – Typical radio 
button. Select Allow unsecured password from the drop-down menu. 
Click OK. See Figure 112 on page 187.
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Figure 112
Security tab

13 Click the Networking tab. Select Internet Protocol (TCP/IP). Click 
Properties.

14 Click the radio button for Use the following IP address. Enter the IP 
address of the OTM server. 

15 Click Advanced. Check all three boxes in the PPP Settings window. 
Click OK.

16 On the Networking tab, click OK.

17 Click Connect in the named dial-up connection window. See Figure 113 
on page 188. No password is required.
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Figure 113
Connect to the DMC8

The screen shown in Figure 114 on page 188 appears.

Figure 114
Registering on the network

The screen shown in Figure 115 on page 189 appears when a successful 
connection has been made.
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Figure 115
Connection complete screen

18 Disconnect the connection by following the on-screen instructions. Close 
the screen. 

19 Restart the OTM PC.

DECT Access System configuration
It is necessary to configure the DECT Access System (DAS). Perform the 
following steps:

1 In OTM-DECT, add a new DAS.

2 Select the Communications tab.

3 Enter the IP address of the DMC8 card.

4 Select Serial and click Details.

5 Select the COM port that DAS uses to connect to the PC.

6 Enter the IP address of the OTM Server in the OTM Server IP Interface 
field.
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Note: The IP address of both the DMC8 card and the OTM Server must 
have the same subnet mask. See Table 69 for an example.

Error messages
If the error message (Connection event) shown in Figure 116 on page 190 
appears, verify the device manager for COM2 in Control Panel > System > 
Hardware > Device Manager > Ports > COM2.

Figure 116
Connection event

Table 69
Sample IP addresses with the same subnet mask

DMC8 IP address 192.168.100.35 

OTM Server IP address    192.168.100.179
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Launch OTM-DECT back-end

To launch the OTM-DECT back-end, perform the following steps:

1 Open the Windows Registry. 
Start > Run>  regedit

See Figure 117 on page 192.

CAUTION
Always ensure the Windows Registry is backed up 
before opening the Registry and its keys.
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Figure 117
Windows Registry 

2 Copy the value of the key 
HKEY_LOCAL_MACHINE\SOFTWARE\NorMat\SMP\OTMSer
vices\DECT\Args

See Figure 118 on page 193.
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Figure 118
Registry key HKEY-LOCAL_MACHINE 

3 Open a command prompt window. At the command prompt, type
java  paste copied text here

(At the command prompt, type java, press the space bar once, and paste 
the contents of the clipboard.)
See Figure 119 on page 194.
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Figure 119
Command prompt with pasted text 

4 Press the Enter key. 
The OTM-DECT back-end is launched. See Figure 120.

Figure 120
OTM-DECT back-end is launched 
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Reference list
The following are the references in this section:

• DECT Installation Guide (553-3601-203)

Feature implementation
The sequence of actions required to configure this feature are as follows:

1 Configure a phantom superloop using LD 97, if required.

2 Create the new DCS sets in LD 10.

3 Configure the RCFW data in LD 57 and LD 15 for handsets assigned as 
a visitor.

4 Use the DECT manager to configure sets on the DMC8.

5 Pre-subscribe the visiting handset one time at the MCDN node.

Note: Subscription includes both overlay configuration and DECT 
Manager configuration. For DECT Manager configuration, see DECT 
Installation Guide (553-3601-203).
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.

LD 10 – Add/Change DCS data block or data blocks. (Part 1 of 2)

Prompt Response Description

REQ: NEW, NEW 1-255, 
CHG, ECHG

NEW = Add a Digital Cordless Set

NEW X = The generation of new DCS units stop when the 
maximum Index of 509 is reached on a single DMC8 or 
VTNs on the system run out or WRLS ISM limits reached. 
All new DCS must be on the same DMC8.

CHG = Allows the DCS configuration to change to another 
DMC8. All new DCS must be on the same DMC8.

ECHG = This command can change either the VSIT 
response or the HMDN response.

TYPE: DCS Digital Cordless Set.
Differentiates between analog sets and non-concentrated 
digital Companion DECT handsets.

If TYPE=DCS, the system allocates the next available VTN, 
and WRLS defaults to YES and WTYP defaults to DECT. If 
package #350 is included, MWUN defaults to 32.

CLS defaults to ERCA, allowing the Enhanced RCFW 
feature.

TN l s c u 
l u

TN on an IPE shelf or Option 11C cabinet. The system 
provides the Virtual TN for the handset.

CDEN (4D) Card Density. Only valid value for IPE is 4D. Normal input is 
<CR>.

WRLS YES WiReLess analog Set - entry defaults to YES with no user 
input - value cannot be CHG’ed.

WTYP DECT Wireless TYPe - entry defaults to DECT with no user input - 
value cannot be CHG’ed.

MWUN 32 Maximum number of Wireless UNits – entry defaults to 32 
with no user input – value cannot be CHG’ed.

Note: If MWUN = 32, CDEN automatically changes to 8D, 
and prints as an 8D unit.

DMC8 l s c

c (Opt.11C)

Location of the actual DMC8.
Assigns a TN to a DECT Mobility Card located on an IPE 
shelf or Option 11C cabinet.
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LD 10 – Copy DCS data block or data blocks.

LD 10 – Remove DCS data block or data blocks.

INDX 0. 509 DMC8 index to map the Virtual TN to a DMC8 TN.

Starting index on DMC8, each unit increments to the next 
available unit.

VSIT (NO)/YES ViSITing DECT set. Determines the difference between a 
local handset and a visiting handset.
VSIT available if the MSMN Package is unrestricted.
YES=visiting DECT set. NO=local DECT set.

HMDN X...X HoMe Directory Number. Sets the DN as a valid MCDN 
network DN.
NMDN available if VSIT=YES.

Prompt Response Description

REQ: CPY 1 – 32 CPY n = The generation of new units stop when the 
following occurs:

maximum index of 509 is reached on a single DMC8 or

VTNs on the system run out or 

WRLS ISM limits reached. 

All DCS must be on the same DMC8.

DMC8 l s c
l (Opt 11C)

Location of the actual DMC8 to copy on an IPE shelf or 
Option 11C cabinet.

Prompt Response Description

REQ: OUT 1-255 OUT X = Removing units stops when the maximum index of 
509 is reached on a single DMC8. All new DCS must be on 
the same DMC8.

DMC8 l s c
l (Opt 11C)

Location of the actual DMC8 to out on an IPE shelf or 
Option 11C cabinet.

LD 10 – Add/Change DCS data block or data blocks. (Part 2 of 2)
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LD 10 – Convert handset type 500 to DCS

Note: To convert from concentrated to non-concentrated, OUT all DCS 
units and re-subscribe the handsets.

The CDCS conversion routine prints each TN as it is moved, in the following 
format:

500 TN l s c 00 = DCS TN L’ S’ C’ Index#.
where: L’ S’ C’ = virtual TN 

Index# = default of the unit number of the 500 type set.

LD 20 – Print actual DMC8 TN and virtual DMC8 TN list.

The print routine outputs the following format:

INDX    Index #    VTN lll s cc uu 
where: Index # = Index number of virtual TN.

lll s cc uu = Virtual TN of unit.

Prompt Response Description

REQ CDCS Convert Digital Cordless Set – convert from a 
non-concentrated to a concentrated system after software 
upgrade. The conversion routine converts the 500 units to 
DCS units and moves them from the actual TN to a virtual 
TN.

Prompt Response Description

REQ PRT Request.

TYPE DCS Digital Cordless Set.

TN l s c 

l (Opt 11C)

l’ s’ c’ u’

l’ u’ (Opt 11C)

Terminal Number for actual DMC8 card on an IPE shelf or 
Option 11C cabinet.

Virtual Terminal Number on an IPE shelf or Option 11C 
cabinet.
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LD 81 – Print DCS features.

The LD 81 output format is as follows:

DCS   Cust#   Local DN   TN lll s cc uu   HMDN   Home 
DN   Last Activity Date.

where: 

• Cust# = Customer Number

• Local DN = Local Directory Number of user

• lll s cc uu = TN of unit

• Home DN = Home directory number of user

• Last Activity Date = Last date of service change activity for user

LD 83 – Prints DCS terminal numbers with a unit type of DCS instead of 500.

Feature operation
To activate the MSMN feature, perform the following steps:

1 Turn the handset on within the coverage range of a visited Companion 
DECT system.

2 Enter the coverage range of a visited Companion DECT system from 
another Companion DECT system with the handset turned on.

Prompt Response Description

REQ LST Request.

FEAT VSIT Feature Request - DECT visitors.

HMDN Xx / <cr> HoMe Directory Number. Specify a single HMDN or print all 
HMDN on system.
DECT Installation Guide



Page 200 of 222  Multi-Site Mobility Networking
To deactivate the MSMN feature, perform the following steps:

1 turn the handset off within coverage range of the visited Companion 
DECT system. (The handset must have the DECT Detach feature.)

2 turn the handset on at the home Companion DECT system. (Any CFW 
related to the handset is cancelled.)

3 enter the coverage range of the home Companion DECT system with the 
handset on (Any CFW related to the handset is cancelled.)
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222
Appendix A: Upgrade a DECT system 
to a SNMP managed system
Contents

This section contains information on the following topics:

Backup the DMC4 data with Windows Manager. . . . . . . . . . . . . . . . . . 203

Upload OTM supporting firmware to the DMC4 Relay card. . . . . . . . . 205

Close the Windows Manager. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Change the DMC4 Relay card default IP address. .. . . . . . . . . . . . . . . . 208
Connect the DMC4 Relay card to a configuring PC. .  . . . . . . . . . . . 208
Reset the DMC4 Relay card to the server IP address. .  . . . . . . . . . . 209

Connect the DMC4 Relay to the OTM server. .  . . . . . . . . . . . . . . . . . . 210

Add the DECT system. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
Add General System Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
Set the DECT system IP address to match the DMC4 Relay card. .. 215

Synchronize data with the DECT system. . . . . . . . . . . . . . . . . . . . . . . . 217

Confirm the active software package on the DMC4 Relay card. .. . . . . 219

Activate the firmware on all DMC4s. .  . . . . . . . . . . . . . . . . . . . . . . . . . 220
Monitor the firmware activation. .  . . . . . . . . . . . . . . . . . . . . . . . . . . 221
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Introduction
There are two types of managers for DECT systems:

• Windows Manager

• OTM with DECT application

The Windows Manager, a non-SNMP device, is used to manage the first 
generation of DECT systems. An OTM with a DECT application manages the 
present generation of DECT systems.

Note: The following terms are used in this appendix:

• The DMC (NTCW00AA) and DMC-E (NTCW01AA) are 
referred to as DMC4 and DMC4-E

• A DECT system equipped with both DMC4/DMC4-E and 
DMC8/DMC8-E is referred to as a Mixed DECT system.

An OTM can manage a DMC4/DMC4-E DECT system or a Mixed DECT 
system.

In a DMC4/DMC4-E DECT system, or a Mixed DECT system managed by 
an OTM, the DMC’s must run SNMP software.

A Mixed DECT system must be managed by an OTM. In a Mixed DECT 
system, a DMC8/DMC8-E must be the relay card.

In a DMC4/DMC4-E DECT system or a Mixed DECT system managed by 
an OTM, the DMCs must run 451001xx.dwl software, and the 
DMC8s/DMC8-Es must run 470001xx.dwl software. If DECT Messaging is 
used, the DMCs must run 451002xx.dwl software, and the DMC8s/DMC8-Es 
must run 470002xx.dwl software

Connecting an OTM to a DMC4 Relay card using an Ethernet connection is 
not supported. Only a V.24 connection can be used.
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Backup the DMC4 data with Windows Manager

Figure 121
DECT Manager window
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Complete the following steps:

Table 70
Backup the DMC data with Windows Manager 

Step Act ion

1 Launch the Windows Manager program.

Double click on the DECT-Manager icon.

2 Select the Companion system.

Highlight the system and click on the OK button.

3 Select the Boards tab.

Place the cursor on the tab and click.

4 Select all DMC4s.

Highlight all addresses.

5 Backup the DMC4 data.

Click on the Backup button.

6 Close the connection to the relay card.

From the toolbar, click on the Connect icon.

END
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Upload OTM supporting firmware to the
DMC4 Relay card

Figure 122
DECT Manager window
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Complete the following steps:

Table 71
Upload OTM supporting firmware to the DMC4 Relay card 

Step Act ion

1 Load the OTM supporting 451001xx.dwl firmware file on the Windows Manager PC.

2 Select the Companion system.

Highlight the system and click on the OK button.

3 Select the Boards tab.

Place the cursor on the tab and click.

4 Select the Relay DMC4.

Highlight the address.

5 Upload the 451001xx.dwl firmware file to the Relay DMC.

From the Boards pull-down menu, click on Upload firmware.

END
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Close the Windows Manager

Figure 123
Close Program dialog

Complete the following steps:

Table 72
Close the Windows Manager

Step Act ion

1 Open the Close Program dialog.

Press the Ctrl + Alt + Delete keys.

2 Disable the Windows Manager.

Select DECT Manager and press the End Task button.

DECT Manager

END
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Change the DMC4 Relay card default 
IP address 

Connect the DMC4 Relay card to a configuring PC 

Figure 124
NTCW12AA cable to configuring PC connections 

Note: The configuring PC can be the OTM server or another PC.
If the configuring PC is the OTM server, the Configuring PC 
shown in Figure 124 will be the OTM Server shown in Figure 126 
on page 211.

CAUTION:  Service interruption
The DMC4 address must be changed to conform to the 
network IP address plan. 

DMC4 Relay card Configuring PC

DECT System

  NTCW12AA
MDF to modem
      cable

 A0773252
Null modem
   adaptor
553-3601-203   Standard 6.00 September  2002



 Page 209 of 222
 

Reset the DMC4 Relay card to the server IP address
Change the Relay DMC4 IP address to conform to the server network IP 
address plan.

Figure 125
Telnet 192.168.1.

Table 73
Connect the DMC4 relay card to a configuring PC

Step Act ion

1 Connect the NTCW12AA cable to the Configuring PC.

Insert the NTCW12AA cable into the A0773252 Null Modem Adaptor and connect to 
the Configuring PC. 

END
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Complete the following steps:

Connect the DMC4 Relay to the OTM server
Connect the OTM server to a DMC4 Relay card using a V.24 connection. 
Connecting an OTM to a DMC4 Relay card using an Ethernet connection is 
not supported.

Table 74
Reset the Relay DMC4 IP address to the LAN IP address

Step Act ion

1 Open the Telnet dialog. 

Click on Start>Accessories>Telnet. 

2 Enter user name and password. 

Type user name dasuser and password dasuser. 

3 When the connection prompt local appears, change the Relay DMC4 card address. 

Enter the following command: 
ipconfig xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy zzz.zzz.zzz.zzz 

xxx.xxx.xxx.xxx = new IP address of the Relay DMC4 card. 

yyy.yyy.yyy.yyy = subnet mask, usually 255.255.255.0 

zzz.zzz.zzz.zzz = IP address if this is the gateway for the network. 

Note:  zzz.zzz.zzz.zzz should be set to the IP address of the OTM server Ethernet 
interface. If there are two Ethernet interfaces on the OT server, zzz.zzz.zzz.zzz should 
be set to the IP address of the interface, which is on the same network as the DMC4 
Relay card.

END
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Figure 126
OTM Server to DMC4 relay connections (local and remote)

DMC4 Relay card

OTM Server

  NTCW12AA
MDF to modem
      cable

 A0773252
Null modem
   adaptor

  Standard
DB-25 to DB-9
      cable

 

DMC4 Relay card
OTM Server

  NTCW12AA
MDF to modem
      cable

  Standard
DB-25 to DB-9
      cable

 

Modem

Local

Remote
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Complete the following step:

Table 75
Connect the DMC4 Relay to the OTM server

Step Act ion

1 Connect the OTM server to the DMC4 Relay card.

Refer to “Add a V.24 serial connection” on page 135.

END
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Add the DECT system
Add General System Properties

Figure 127
DECT Systems and DECT System Properties
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Complete the following steps:

Table 76
Add the DECT system

Step Act ion

1 Open the DECT System Properties dialog.

Pull down File>Add. 

2 Enter the DECT system name.

Type the system name in the DECT System Name box.

3 Accept the changes.

Click on the Apply button.

END
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Set the DECT system IP address to match
the DMC4 Relay card

Figure 128
System Properties – Communication
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Complete the following steps:

Table 77
Set the IP address of the DMC4 Relay card in the manager

Step Act ion

1 Open the Communications dialog.

Click on the Communications tab.

2 Enter the IP address.

Type the IP address that was entered in Table 74 on page 210.

3 Select Serial.

Click on Serial radio button, and go to “Add a V.24 serial connection” on page 135.

4 Accept the changes.

Click on the OK button.

Note:  When the OK button or Apply button is clicked at this point, the manager attempts 
to connect to the DECT system to write the MIB2 system name. 

END
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Synchronize data with the DECT system
When the DECT manager connects to the DECT system, synchronization 
occurs. The OTM database can be updated with the DECT system data.

Figure 129
DECT Systems, and a synchronize dialog
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Complete the following steps:

Table 78
Synchronize data with the DECT system

Step Act ion

1 If the toolbar icon is red, indicating the DECT system connection is enabled, disconnect 
from the DECT system.

Double click on the icon, or use File>Disonnect. Go to step 3.

2 If the toolbar icon is green. 

Go to step 3.

3 Re-connect to the DECT system.

Double click on the red icon, or use File>Connect.

4 Store the DECT system data in the OTM Manager database.

Click on the Update DECT Manager button on all synchronization dialogs.

END
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Confirm the active software package on the
DMC4 Relay card

Figure 130
DMC window and DECT Board properties dialog

Complete the following steps:

Table 79
Confirm the active software package on the DMC4 Relay card 

Step Act ion

1 Examine the Active Software Package on the DMC4 relay in the DMC window list.

Active Software Package must be 451001xx.dwl firmware, the same one that was 
loaded on page 205.

2 Close the DMC window.

Click on the close box.

END
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Activate the firmware on all DMC4s

Figure 131
DECT Systems window
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Complete the following step:

Monitor the firmware activation

Figure 132
DMC window

Table 80
Activate the firmware on all DMC4s

Step Act ion

1 Activate the 451001xx.dwl firmware the same as was loaded on page 205 to all 
DMC4s.

From the Firmware pull-down menu, click on Activate.

END
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Complete the following step:

Table 81
Monitor the firmware activation 

Step Act ion

1 Examine the Active Software Package on the DMC4 relay card in the DMC window list.

Active Software Package must be 451001xx.dwl firmware on all DMCs. See page 205.

END
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